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Overview  
FastExcel Profiler gives you a wide variety of tools to analyze, manage, control and optimize the 
performance and memory usage of your workbooks. These tools fall into three main groups: 
 
FastExcel Calculation Profiler  
FastExcel Calculation Profiler finds and prioritises and Excel calculation bottlenecks. 
When using the Trial version only the Drill-Down Wizard is available and it is restricted to profiling a 
single worksheet. 

 Drill-down Profiler Wizard 

 Profile Workbook 

 Profile Worksheet Formulas and Functions 

 Profile Worksheet Areas 

 Map Worksheet Cross References: This command maps the flow of calculations between 
worksheets. 

 Memory and Versions shows memory used and available, and the versions of Excel and 
Windows being used. 

 Check Workbook shows statistics and potential trouble spots in the active workbook. 
 
FastExcel VBA Profiler  
FastExcel VBA Profiler measures the time each VBA procedure takes to execute. 

 Choose the projects, modules and procedures to profile 
 Choose either to profile execution time or to trace execution flow 
 Profiling report shows execution time from highest to lowest 
 Easy-to-use methods for drilling down to profile loops and blocks of VBA 
 Individual iterations of Loops can be profiled 

 
Many thanks to Stephen Bullen and Rob Bovey for their help with ProfVBA: see pages 546-500 of 
“Professional Excel Development” ISBN 0-321-50879-3. 
And many thanks also to Don Soloway who extended ProfVBA to handle profiling of Loops and Iterations 
of Loops. 
 
FastExcel Calculation Manager 

Calculation Manager times and controls Excel’s calculation engine. 

 Calculate Range 

 Calculate Sheet 

 Calculate Workbook 

 Time a Macro 

These tools can be used during development and optimization of a workbook to quickly compare the 
calculation speeds of different formulas, worksheets etc., and, with large slow workbooks, allow you to 
quickly calculate a small subset of the workbook. 
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Installing FastExcel V4 Profiler 
FastExcel V4 Profiler requires: 

 One of Excel 2007, Excel 2010, Excel 2013, Excel 2016, Excel 2019 or Office 365 Excel 
 Either 32- or 64-bit Excel 
 A Microsoft supported version of either 32- or 64-bit Windows 
 .NET Version 4 or later 

Two install methods are available: 

 Automatic Installer: requires Administrative level privileges. 
 Manual Installer: requires more manual steps than the automatic controller, but does NOT 

require Administrative level privileges. 

Automatic Installer (requires Admin level privileges) 
Download the Automatic Install Beta zip file from the Decision Models website 

http://www.DecisionModels.com/Downloads/InstallV4Profiler.zip 

Automatic Installation requires administrative privileges. 

1. Extract the installer .exe file from the downloaded zip 

2. Double-click the extracted installer .exe file and follow the instructions to create a 
FastExcel V4 folder containing subfolders for each FastExcel V4 product. The default 
directory is called FastExcel V4 and is located in your Program Files (x86) directory. 

Help files (.CHM) and a PDF version of the User guide will also be installed in these folders. 

After successful installation FastExcel V4 will automatically be started when you start Excel, 
and you will find FastExcel V4 tabs for each installed product on the main ribbon. 

 

If the ribbon does not show any FastExcel V4 tabs, or the installation was done for you by 
another user with administrative privileges, you may have to use the Manual Install 
instructions below: 

Manual Installation for Windows 
1. Create the FastExcelV4 folder 

Extract the FastExcelV4 folder from the downloaded zip file to your chosen location 

The FastExcelV4 folder contains up to 3 sub-folders, depending on which Manual Installer 
you chose: 
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 FastExcel V4 Profiler 
 FastExcel V4 Manager Pro 
 FastExcel V4 SpeedTools 

Each of these sub-folders contains an .XLAM file you need to load into Excel using Excel's 
Addin Manager. 

2. Unblock all the XLAM, XLL and DLL files 

Windows often blocks downloaded files. 

To unblock a file: 

 The files you may need to unblock are: 
o FastExcelV4/FastExcel V4 Profiler/FxlV4Profiler.xlam 
o FastExcelV4/FastExcel V4 Profiler/QlmCLRHost_x64.dll 
o FastExcelV4/FastExcel V4 Profiler/QlmCLRHost_x86.dll 
o FastExcelV4/FastExcel V4 Profiler/QlmLicenseLib.dll 

 Browse to each file, Select and Right-click it then select Properties 
 Click the Unblock button 

 
3. Make the FastExcelV4 folder a Trusted Location 
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Start Excel and use File->Options->Trust Center->Trust Center Settings->Trusted 
Locations->Add new location->Browse to your FastExcelV4 folder->Check Subfolders of this 
Location are also trusted->OK 

 

4. Use Excel's Addin Manager to install each FastExcel V4 addin 

For Excel 2007 Click Office Button->Excel Options->Addins->Excel Addins->Go…  
For Excel 2010, 2013, 2016, 2019 and Excel 365 Click File->Excel Options->Addins-
>Manage Excel Addins->Go… 

 Press Browse and locate the FastExcelV4 folder. 
 In the FastExcel V4 Profiler sub-folder select the FxlV4Profiler.xlam file and click 

OK to return to the Addins form. 
 If asked “Do you want to copy this Addin to the Addins folder?” reply NO. 
 The Excel Addins form should now show the FastExcel V4 addins with a checkmark. 

Click OK to finish. 

 
5. Recommended Trust Center Settings 
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The recommended settings for addins and macros are: 
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Quick Start Calculation Profiling:  Drill Down 
If you would like to get some immediate profiling results on your workbooks without delving into lots of 
details you can simply use the Drill-down Profiler Wizard to find the Calculation Bottlenecks.  
Once you are more familiar with some of FastExcel's features you can use the online help and FastExcel 
manuals to investigate additional ways of finding and eliminating bottlenecks.  

 

Click Drill-down to Profile the active Workbook and up to 5 of the slowest worksheets: Note that the 
Trial Version only profiles a single worksheet 

Find the problem 
worksheets, volatility and 
multi-threading 
inefficiencies 

When you click the Drill-down wizard button it first profiles the 
active workbook to find and prioritize: 

 The calculation times for each worksheet. 
 Workbook and worksheet Volatility and multi-threaded efficiency 
 Used Range wastage by worksheet. 

 

Find the worst formulas 
on the 5 worst sheets 

Then the Drill-down wizard will automatically drill down step-by-step to 
profile the formulas on the worst 5 worksheets that contribute > 5% of the 
total calculation time. For each unique formula on each sheet you will see: 

 % Contribution to total sheet calculation time 
 Total and average calculation time 
 Count and address of the formula 
 Flags for CSE array formulas, Volatile, single-threaded formulas 

and formulas using UDFs. 
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Quick Start Calculation Profiling Reports 
The Drill-down Wizard creates profile report sheets for: 

 The workbook and its worksheets (sorted by calculation time). 
 The formulas (sorted by calculation time) on the worst worksheets 

Look for items that are highlighted in orange 

The calculation profiler highlights in orange the potential problem areas you should look at. 
You can see explanations of items by selecting a cell with a red triangle. 

Worksheet potential problems 

 Unique Formulas: Orange if any formulas contain full column references 
 Conditional Formats Count: Orange if there are on average a large number of rules for each cell. 
 What-If Data tables: Always orange 
 Full Calc Time: Times are orange for sheets that are significantly above average 
 Sheet Volatile %: Orange if calculation is significantly volatile for this sheet 
 Used Range Waste: Orange if significant waste 

Worksheet Formulas Profile potential problems 

 Formulas using a significant % of the worksheet calculation time are flagged orange. 
 Volatile functions, single-threaded functions and UDFs are flagged orange. 

Volatility % 

When your worksheets contain formulas with volatile functions (INDIRECT, OFFSET, RAND, NOW …) 
calculation will be slow any time you make a change to the workbook. 

Multi-threading Efficiency 

 Excel’s calculation engine tries to share out the calculation load across the cores of your PC. 
But some functions (INDIRECT, GETPIVOTDATA, most User Defined Functions etc.) are single-threaded 
and so block effective use of the cores on your PC. 
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Quick Start VBA Profiling 
The FastExcel VBA Profiler provides an easy-to-use way of finding out which parts of a VBA solution are 
using the most execution time. The profiler works by adding timing calls to your VBA. These timing calls 
store timing information whilst your VBA code runs. Then a profiling report can be produced showing 
the slowest parts of the VBA first. The VBA Profiling commands are available from: 

 The Ribbon 
 The ProfVBA Toolbar in the VBE 
 The ProfVBA Menu in the VBE Addins Menu 
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The 4 Step VBA Profiling VBA Process 

“Add Profiler Calls”  “Enable Profiling”  run your VBA  “Show Profiling Report" 

Profiling your VBA 

1. Make sure that you have enabled Access to the VBA Object Model (File->Options->Trust Centre-
>Settings->Macro Settings) 

2. Use the VBIDE (Alt-F11) to unprotect the VBA you want to profile. 
3. Use “Add Profiler Calls” to choose which projects, modules and procedures to Profile. 
4. Enable Profiling 
5. Run the VBA code you want to profile 
6. “Show Profiling Report” to create the profiling report worksheet. 

Drilling down within VBA Procedures 

There are 3 different ways you can drilldown the profiling to within a specific VBA Procedure. 

1. To profile a particular block of VBA statements, select them in the VBA and then use “Profile 
Statements”. 

2. To profile all the Loops in a particular VBA Procedure, select any line in the procedure that 
contains the Loops, then click “Profile Loops”  

3. Use “Add Profiler Calls”, select a Project, Module and Procedure then choose “Every Nth line 
of Proc” 

Cleaning Up 

Don’t forget to “Remove Profiler Calls” to clean up your VBA! 

Note: 

The FastExcel timing buttons will work with VBA Profiling so that UDFs and VBA calculation event code 
can be profiled, but the FastExcel Profiling commands ignore VBA profiling because they trigger multiple 
calculation events. 
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FastExcel VBA Profiling Report 
“Show Profiling Report” creates a report worksheet in a separate workbook. 

The report timings are by default exclusive: they show the timed used by a procedure excluding the time 
taken by the calls from that procedure to other procedures. You can switch to Inclusive timing from the 
Enable Profiling command. 

In this example SetAllExpColors is using 68% of the execution time.  

You could then drill-down into SetAllExpColors to see which VBA statements are taking the time. 

It turns out that the profile shows that 85% of the time is used turning Screen Updating back on after 
colouring the cells. 
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Call Sequence Counts 

The Profiler maintains independent calling sequence counts for the first calls to a procedure and the last 
exit from a procedure. So, if Proc1 is the first Proc and calls Proc2 which then exits and returns to Proc1 
which then exits you would get: 

Proc Name Start Sequence Exit Sequence 

Proc1 1 2 

Proc2 2 1 

 

Sorting by Start Sequence or Exit Sequence gives a quick way of looking at the starting or ending flow of 
your procedure calls. 

For a more comprehensive trace see FastExcel Trace below. 
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FastExcel Trace Report 
The Trace report is written to a .txt file in the same folder as the active workbook. 

 

The starting number and indentation show the start and end calling level for the procedure. 



FastExcel V4 Profiler User Guide Page    17 

Using FastExcel Calculation Profiling 
To make the best of the Drill-down wizard it’s a good idea to read this background material on profiling 
Excel calculations. 

Full Calculation, Recalculation and Volatility: What and Why 

To get the best out of FastExcel you need to understand the difference between an Excel Recalculation, 
where Excel works out how to recalculate the smallest number of formulas possible, and an Excel Full 
Calculation, where Excel calculates every single formula regardless of whether it has already been 
calculated or not.  

Volatile formulas get 
recalculated at every 
calculation. 

Which of these types of calculation is more important for you depends 
on how much of the input data changes each time you want to calculate 
the workbook, and how many volatile formulas you have. FastExcel V4 
Profiler will measure the volatility of each worksheet and can identify 
which built-in and XLL based functions are volatile. 

For example, if you are doing a monthly budget variance analysis each month most of the input data will 
change and almost all the formulas will need to be recalculated. 

But if you are doing a what-if analysis on a cash-flow model then you may change only a single input 
number that will cause only a small number of the formulas to be recalculated. 

If possible, you should decide which of these two scenarios is the most frequent for your workbook, 
because it can significantly affect which part of your FastExcel Profiling analysis is most significant for 
you, and also the methods you use to optimize your workbook calculations. 

Multi-Threaded Calculation: What and Why 

In Excel 2007 the Excel calculation engine was rewritten to use all the available CPUs/cores in your PC. 
This method of multi-threaded calculation can have a dramatic effect on your Excel calculation times: on 
a 4-core PC a well-designed workbook can run up to 4 times faster than with single-threaded calculation. 

But some worksheet functions (all VBA user-defined functions and many add-in library functions) are 
single-threaded and so will seriously slow down calculation. 

FastExcel V4 Profiler can measure the multithreaded efficiency both of the individual worksheets and 
the overall workbook, and can identify any single-threaded functions being used. 
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How FastExcel V4 helps you run Excel faster: 
You can speed up your 
Spreadsheet by finding and 
eliminating calculation 
bottlenecks 

Most slow-running spreadsheets contain a small number of problem 
areas, or Bottlenecks. 
Because Excel is such a flexible spreadsheet system there are usually 
many different formulas that can produce the answer you want. Some 
of these formulas are much faster than others. 

In large spreadsheets it can be difficult to locate and prioritize the 
Bottlenecks. 
You can use the Drill-down wizard and the wide variety of timing and 
profiling tools in FastExcel to rapidly drill down, locate and prioritize 
these bottlenecks. 

FastExcel V4 helps you find 
and prioritize bottlenecks 
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Optimizing Excel Calculation Bottlenecks 
Most Excel spreadsheets contain a number of calculation bottlenecks. Some of the most common 
bottlenecks are: 

 Exact Match Lookup using MATCH, VLOOKUP, and HLOOKUP: Excel has to 
scan through each row of the data table until it finds a match. This can be 
very slow for large tables. 

 Array Formulas and SUMPRODUCT: Using Array formulas and 
SUMPRODUCT can do amazing things, but forces Excel to do many 
calculations, which often results in slow calculations.  

 Excel calculating more than you need: you can use FastExcel to more 
precisely control which parts of your workbooks should be calculated. 

 SUM, SUBTOTAL, SUMIF, and COUNTIF: These formulas can make Excel 
scan a large number of cells. 

 Single-threaded Functions: Using single-threaded worksheet functions such 
as INDIRECT can slow down calculation by a large factor. 

 User-Defined Functions: There are significant overheads involved in calling 
VBA UDFs and in transferring data from Excel to the UDF. With care these 
overheads can be minimized. 

 Volatile Functions: Using volatile functions such as OFFSET or INDIRECT 
means that Excel cannot get the best out its smart recalculation engine so 
that each recalculation takes longer. 

 Conditional Formats: A large number of conditional formats can significantly 
slow workbook calculation. 

 Large Ranges: Using larger ranges than necessary can be expensive for 
calculation time. 

 Duplicated calculations: it is very easy to build a spreadsheet where many of 
the calculations are being repeated many times. 

 Workbook Links: Links to other workbooks are slow and fragile. 

 What-If Data Tables: Data Tables use single-threaded iterative calculation 
methods which are slow. 
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Use FastExcel V4 to Eliminate Calculation Bottlenecks 
Once you have identified and prioritized the calculation bottlenecks you can set about eliminating and 
reducing them: 

Slow Lookups and Matches 

 Use SpeedTools's advanced memory lookup technology to speed up recalculation of exact 
match lookups. 

 Sort the data and use SpeedTools super-fast sorted exact match lookup.  

 SpeedTools MEMMATCH, MEMLOOKUP, AVLOOKUP2 and AMATCH2 all use memory lookup 
and sorted exact match lookup 

 Use SpeedTools AVLOOKUP2 and AMATCH2 built-in exact match error handling 

 Handle multiple-condition lookups efficiently with SpeedTools AVLOOKUP2 and AMATCH2 
rather than using slow array formulas or concatenation 

Slow Array Formulas and SUMPRODUCT formulas 

 Use SpeedTools FILTER.IFS powerful and efficient multiple condition handling to replace slow 
SUMPRODUCT and array formulas. 

 Sort your data and use SpeedTools FILTER.IFS ability to exploit sorted data efficiently 

 Minimize the effective size of the ranges you are using with FastExcel Managers Dynamic 
Range Wizard (part of FastExcel V4 Name Manager Pro) 

Eliminate Unnecessary Calculations 

 Use FastExcel V4 SpeedTools’ extended calculation options to control exactly which parts of 
your spreadsheets should be calculated. 

 Look for duplicated calculations in formulas or parts of formulas and break them out into a 
separate column so that they only have to be done once. 

Slow VBA UDFs 

 Installing FastExcel V4 SpeedTools will bypass Excel’s VBE UDF refresh bug and speed up 
calculation when you have a large number of VBA UDFs. 

 SpeedTools powerful and extensive range of functions may be able to replace some of your VBA 
UDFs 
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How fast should my spreadsheet calculate? 
Studies on the effects of slow response time (see below) show that there are two ‘comfort zones’ of 
calculation times for users: 

 For calculation times of less than about a tenth of a second users feel comfortable with 
Automatic Calculation. 

 For calculation times of up to about 10 seconds in Manual Calculation mode users can maintain 
concentration and avoid errors. 

So wherever possible you should try to use FastExcel to get your workbook calculation speed into one 
of these comfort zones. 

The Effects of Slow Response Time 

 Research studies show that a user’s productivity and ability to focus on the task deteriorate as 
response time lengthens. 

 Response time greater than 10 seconds: 

Users generally refuse to 
wait longer than 10 
seconds 

When response time is longer than 10 seconds users tend to switch to 
other tasks. 

 Response time greater than 1 second but less than 10 seconds: 

User errors, and 
annoyance level, start to 
increase, particularly for 
repetitive tasks 

When response time is less than 10 seconds but longer than 1 second 
the user has difficulty in retaining a train of thought, but will probably 
not have switched to doing a different task whilst they are waiting. 

 Sub-Second Response: 

Improving calculation 
speed to less than a second 
increases productivity 

For response times greater than a tenth of a second but still less than 
about 1 second, users can successfully keep a train of thought going, 
although they will notice the response time delay. IBM studies from the 
1970s and 1980s showed significant productivity gains for users when 
response times were less than a second. 

You will probably need to switch to Manual Calculation mode when entering data. 

 Instant response 
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The FastExcel Profiler Ribbon 

  

FastExcel V4 Profiler shows an additional  tab on the main Ribbon. 

 

Calculation Profiling Commands:  

The FastExcel profiling 
commands allow you to 
find calculation bottlenecks 

 

Drill-Down Profiling Wizard, Profile Workbook, Profile Formulas, Profile 
Worksheet, Map worksheet cross-references, show Excel memory usage 
and Limits, produce a Check Workbook report. 

VBA Profiling Commands 

 

The VBA Profiling commands provide an easy-to-use way of profiling and tracing the flow of execution of 
your VBA projects. 

Extended Excel Calculation Option and Calculation Timing Commands: 
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The FastExcel Calculation 
Settings button allows you 
to control both Excel and 
FastExcel Calculation 
settings. 

Calculation Settings for Excel, the Active Workbook and FastExcel. 
Includes Initial Mode, Mixed Mode and Active Book Calculation Modes. 
Show and change FastExcel V4 licensing options. 

Calculate range, Recalculate selected sheets, Full calculate Sheet, 
Recalculate workbooks, Full calculate workbooks and Recalculate 
MixMode sheets and workbooks. 

FastExcel Help buttons: 
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FastExcel Calculation Profiler 

 

Five Calculation Profiling Commands 
Note: when using the trial version of FastExcel only the DrillDown profiler command is available and it is 
restricted to a single worksheet. 

Drill-down Profiler Wizard: This guides you to drill down to find the calculation bottlenecks from 
workbook to the individual formulas on the slowest worksheets. 

Profile Workbook: Analyzes the calculation times of your workbook and worksheets.  

Profile Worksheet Formulas and Functions: This analyzes the calculation times for unique formulas on a 
worksheet and identifies the functions used that are volatile or single-threaded. 

Profile Worksheet Areas: This analyzes formula calculation times for the columns, rows and blocks of 
formulas in one or more of your worksheets.  

Map Worksheet Cross-References: This analyzes the cross-references between worksheets and 
optionally re-sequences the worksheets to minimize forward cross-references. 

You can get Contextual Help on the output from the profiling commands either by right-clicking a 
selected cell on the output sheet or by selecting a cell and pressing the FastExcel Contextual Help button. 

Potential bottlenecks are highlighted in orange. The sensitivity of the orange highlighting can be 
controlled by setting FastExcel’s Orange Tolerance (default 0.2) on the FastExcel Settings page: Cell 
Highlight (Orange) sensitivity. 

The profiling commands help you to document calculation options, and generate timing statistics and 
memory usage details. 

The profiling commands generate result worksheets into a separate workbook, using sheets called: 

 FastXLBookn: The workbook profile results 

 FastXLSheetn: the worksheet profile results 

 FastXLFuncsn: the worksheet formulas and functions profile results 

 FastXLPrecsn: the worksheet cross-reference map results 

Multiple profiles of a given type are given an incremental number suffix. 
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Memory and Versions 
FastExcel provides a simple way of finding how much memory your workbooks are using and what the 
maximum available amount of memory for your Excel configuration is. 

 

Check Workbook 
Check Workbook provides a quick way of checking a workbook for potential problems and showing 
statistics. The report is similar to the Profile Workbook report but replaces calculation timings with 
additional statistics. 
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The Profiling Header 

All five profiling commands document the profiled workbook by showing a common set of header tables: 

The Physical Environment Table 

Cells with red dots contain 
on-sheet Notes: hover your 
cursor to make them pop-
up. 

 

The Physical Environment Table shows information about the system. 
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Orange if Memory 
Used>1MB and (Memory 
Used +64)>RAM (MB) 

 RAM (MB): Physical Memory Used and installed in 
megabytes. You should have at least enough physical 
memory installed for Windows, Excel and all the open 
workbooks. See Bottlenecks.  

 Swap File (MB): Swap File used and Swap file available in 
megabytes. If your system is using a large amount of your 
existing swap file either close as many programs as possible 
or increase the size of your swap file. 

 Excel Memory (MB): Excel Memory Used and available. 
Total Memory Used by all open Excel workbooks for data, 
formulas etc. (excludes Memory Used by the Excel program 
itself), and the maximum Excel workbook memory available 
for formulas etc. Megabytes.  

Orange if Used/Available > 
3.75 * Orange Tolerance 

Orange if Used/Available> 
3.75*Orange Tolerance 

 File Size (K): The size on disk of the workbook in Kilobytes. 

 Operating System: The version of OS in use when this 
profile was created. 

 MHZ x Cores: The processor speed in MHZ, and the number 
of processor cores in the system. 

 XLVersion: the Excel version number and bitness used for 
this profile: 

 Excel 97 is Version 8 

 Excel 2000 is Version 9 

 Excel 2002 is Version 10 

 Excel 2003 is Version 11 

 Excel 2007 is Version 12 

 Excel 2010 is Version 14 

 Excel 2013 is Version 15 

 Excel 2016 is version 16 

 XL Calculation Engine: The version number of the 
calculation engine that was used for this profile. If not Excel 
2000 or a later version, N/A.  
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The Workbook Settings Table. 

 

The Workbook Settings Table shows basic information on the profiled workbook: 

 The name and path of the profiled workbook and the date 
and time that the profile was created. (Not shown in the 
above picture) 

If Shared and Keep Change 
History are both true they 
are colored orange. 

 Shared: True if the Workbook is open for Sharing. If Shared 
and Keep Change History are both true the Workbook size 
can grow considerably. 

 Changes: Keep Change History Tracking: True if enabled, 
otherwise False. If Shared and Keep Change History are 
both true the Workbook size can grow considerably. 

 Saved: False if the workbook has been changed in any way 
since the last save. 

Avoid saving in Dual 
Format 

 Format: the format of the saved workbook: Dual Format 
(Orange) doubles the file size. 

 Fixed: Fixed Decimal: If True numbers will be treated as 
having an implied decimal point, in the position given by 
Places below. 

 Places: The position of the implied decimal point, if Fixed 
Decimal is true. 

 Backup: True if a backup copy of the workbook will be 
created when you save. 

 Styles: The number of Styles in the workbook. If this number 
is large you may want to use Clean Workbook to map where 
the styles are being used, and to remove unused styles. 

 Protection: The following three items show the protection 
status of the Workbook structure and windows, and 
whether the book is password protected. 

Colored orange if true  Structure: True if the structure of the workbook is 
protected. If protected with a password then opening the 
workbook will be slow. 

 Worksheets: True if the worksheets in the workbook are 
protected. 

 Password: True if the workbook is Password protected. 
 Views: The number of Views in the workbook. 
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The Environment Counts Table 

 

 

 

 

 

 

 

Colored orange if >100 

 

 

 

 

 

 XLB/Qat (K): The size of the XLB and QAT files in K Bytes. 
The XLB file stores toolbar customizations. The QAT file 
stores ribbon customizations. 
When they get large, they may become corrupted and 
cause memory problems. 
The XLB file is located in %AppData%\Microsoft\Excel and 
the QAT file is located in 
%LocalAppData%\Microsoft\Office\ 

 COM Addins: The number of COM addins currently loaded 

 Temp: Count of the temporary files in your Windows 
temporary directory and subfolders. A large number of 
Temp files may make your workbook slow to open or cause 
Excel to crash. The Clean Workbook command can delete all 
temporary files that are not currently being used. 

Note: a very large number of temp files may cause FastExcel to 
hang with the status bar showing “Checking Temp Files”. If this 
occurs close Excel, reboot your PC and then delete all files in 
your temp folder. You can locate your temp folder using 
StartRun, entering %temp% in the run box and pressing 
enter. 

 VBE: Total Number of Windows in use by the VBE IDE. 
Includes hidden windows. A large number of open VBE 
Windows consumes resources and may cause memory 
problems. (If blank in Excel 2002 or later check "Allow 
access to Visual Basic Project" in Tools, Macros, and 
Security). The Clean Workbook command can close all 
unnecessary VBE Windows. 

Colored orange if >15 

 Addins: The number of Excel Add-Ins currently loaded by 
Excel’s Addin Manager. This excludes any addins that have 
been loaded using File Open or the Decision Models Addin 
Loader. 
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The Calculation Settings Tables. 

See FastExcel Calculation 
Settings for a detailed 
description of these options 
and how to set them  You can use the FastExcel Calculation Options button to change 

these calculation settings. 

The Excel Calculation Settings Table 

By default, Excel Calculation 
Settings apply to all currently 
open workbooks. 

 

 

 
FastExcel Active Workbook 
mode allows you to control 
Calculation for the active 
workbook instead of all 
open workbooks. 

 Workbook Mode: All or Active Book.  
The Excel default is to calculate all the open workbooks. With 
FastExcel you can restrict calculation to the active workbook 
only (and each workbook can have a different calculation mode, 
see Mixed Mode processing). 

FastExcel Mixed Mode 
allows you to select sheets 
as MixMode sheets and 
control whether they will 
be calculated in 
Automatic, Manual or 
Sheet calculate. 

 Current Mode: Automatic, Manual or Semiautomatic.  
This mode applies to all the open workbooks or just to the 
active book. The Excel default is to apply this mode to all the 
worksheets in a book. With FastExcel’s Mixed Mode you can 
control which worksheets are calculated in Automatic or 
Manual or Sheet Calculate mode. 

 Before Save:  
If True Excel will recalculate before each save. Any worksheets 
that are NOT enabled for calculation will not be calculated. 

 Initial Mode: Controls how Excel sets the calculation mode 
when started. 
First Workbook (Excel Default): Calculation mode is set from the 
first workbook opened. 
Automatic: Calculation mode will be set to automatic. 
Manual: Calculation mode will be set to Manual. 
Semi-Automatic: Calculation mode will be set to Automatic 
except Tables. 

 Iteration: If TRUE Excel will attempt to resolve circular 
references by iteration. 

 Max Iters: the maximum number of iterations used to resolve 
circular references. 

 MaxChange: Iteration will stop when no cell changes by more 
than MaxChange 
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 Multi-Threaded Calc: Calculation using multiple cores and 
threads 

 On: True/False/ #N/A Shows if Multi-Threaded Calculation 
(MTC) is on, off or not available 

 Mode: Automatic – Excel assigns a calculation thread to each 
available core. Manual – the user has assigned a specific number 
of threads. 

 Threads: The number of threads assigned to the calculation. 
 Force Full Calc: Shows if this workbook will use Excel’s smart 

recalc or always calculate every formula in the workbook at each 
calculation. 

 Full/Recalc:  
Full: every formula in all open workbooks will be calculated at 
each calculation 
Recalc: only changed formulas and formulas dependent on 
changed values/volatile cells will be recalculated 
XL 64K Limit: in Excel versions prior to Excel 2007 Excel switched 
to force-full calculation when dependencies exceeded 64K. 
Colored orange if this limit has been reached 
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The Workbook Calculation Settings Table 

These settings can be 
different for each open 
workbook 

 

 Mixed Mode allows you to choose when any MixMode 
sheets will be calculated. 

 Full: If True any MixMode worksheets will be recalculated at 
each full recalculation (Ctrl/Alt/F9). 

 Manual: If True any MixMode worksheets will be 
recalculated at each Manual calculation (F9). 

 Selected Sheets: If true then any MixMode sheets that are 
selected will be calculated when Sheet Calculate or Shift-F9 
is pressed. 

 
You can use Mixed Mode 
so that some worksheets 
always calculate and 
others calculate only when 
you want. 

 Restore After Open: If True then FastExcel will automatically 
reset the calculation mode after the workbook has been 
opened to the mode that was active when the workbook 
was saved, or in Active Workbook Mode to the mode stored 
in the workbook 

 MixMode on Open: If Excel is in Automatic mode then all 
the MixMode sheets in the workbook being opened will be 
recalculated. If Excel is in Manual mode any MixMode 
sheets will not be calculated when the workbook is opened 
unless this option is True. 

 Update Remote Refs: If TRUE automatically update any 
remote references (DDE Links to other programs) whenever 
Excel recalculates. 

 Precision as Displayed: If TRUE uses the displayed value of 
all cells rather than their real value as input to subsequent 
formulas. 
Be careful because this also permanently changes the values 
of numeric constants. 

 1904 Date System: if True changes the starting date from 
which all dates are calculated from January 1 1900 to 
January 2 1904. 

 Save External Link Values: If TRUE Excel saves values for 
links to external workbooks.  

  Book Calc Engine: The version number of the calculation 
engine that last calculated the workbook (if not Excel 2000 
or a later version then N/A). Colored orange if less than the 
Application calculation version 
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Profile Workbook 

 Profile Workbook: Profile the active workbook and all its worksheets. 
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Because Excel calculates all open workbooks rather than just the active workbook you can get 
misleading calculation times if you have multiple workbooks open during Profile Workbook. 
 

 
 
Choose Profile Workbook Options 

 Because Profile Workbook can take a long time to execute these options allow you to include or 
omit various profiling options: 

 Profile all the worksheets: if switched off the individual worksheets will not be profiled. 
 Profile Multi-Threaded Calculation: If checked each worksheet will be calculated once using 

multi-threaded calculation and once without so that the multi-threaded calculation efficiency of 
each sheet can be determined. 

 Profile Worksheet Volatility: If checked each worksheet will be calculated once using smart 
Recalc and once using Full Calculation so that the worksheet volatility can be determined. 

 Profile Worksheet Sparseness: If checked the number of cells containing constants will be 
counted and the sparseness % of the real used range will be calculated. 

 Profile the workbook itself: If switched off the workbook itself will not be profiled. 
 Profile Multi-threaded Calculation: if checked the workbook will be calculated once using MTC 

and once without so that the multi-threaded calculation efficiency of the workbook can be 
determined. 

 Profile Workbook Volatility: If checked the workbook will be calculated once using smart Recalc 
and once using Full Calculation so that the workbook volatility can be determined. 

 Events during Calculation: Profile Workbook will by default attempt to prevent VBA events from 
occurring during the timed calculations. If your workbook contains event-handling VBA code you 
should consider whether to include or exclude it when running Profile Workbook. 

 Ignore VBA Errors. Profiler will attempt to ignore VBA errors in the workbook being profiled. 
 Set Warning Tolerance: a larger tolerance number reduces the number of orange warnings 

produced. 
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Profile Workbook produces information in several tables: 

 Excel and Workbook environment information and calculation options. 

 Worksheet statistics, calculation times, volatility and multi-threaded efficiency  

 Workbook summary 

Potential bottlenecks are highlighted in orange. The sensitivity of the orange highlighting can be 
controlled by setting FastExcel’s Orange Tolerance (default 0.2).  
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The Worksheet Profiles Table. 

The Worksheet Profiles Table shows the cell counts, calculation times and Memory Used for each 
worksheet. The table is only produced if the Profile All the Worksheets option is checked in the Profile 
Workbook Options. 

The worksheets are sorted in descending sheet calculation time. 

The Worksheet Profiles Table: Cell Counts Columns 

Cell counts show 
you the key size 
statistics for each 
worksheet. 

 

The Cell Counts columns show counts of the number of cells for: 

 Used: The Used Range: The rectangular table of cells that Excel considers used: Excel considers cells 
with formatting, data or formulas used. The Used Range is not automatically reset when cells are 
deleted or cleared.  
You can clean up the Used Range with Clean Workbook. 

 Constants: the number of constants on this worksheet. 

 Formulas: the number of formulas on this worksheet. 

 Unique Formulas: the number of different formulas on this worksheet. 

 CSE Formulas: the number of array entered (Control-Shift-Enter) formulas on this worksheet. 

 CondFmt: the total number of conditional formats on this worksheet. Colored orange if the average 
number of conditional formats per conditionally formatted cells is > 3. 

 What-If Tables: the number of iterative what-if data tables on this worksheet. 
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The Worksheet Profiles Table: Calculation Times. 

 
In the actual FastExcel output these columns are adjacent to the cell counts columns rather than as 
shown above. 

Calc Time (Millisec); the elapsed calculation times in milliseconds. 

Use this table to identify 
the sheets that use the 
most calculation time, 
any sheets with 
significant volatility or 
MTC inefficiency and the 
sheets that have the 
most expensive 
formulas. 
 

Single-Thread: Time in milliseconds for a Range.Calculate of the real used 
range in the worksheet, not using multi-threaded calculation, minus 
the time taken to range calculate an empty worksheet (empty sheet 
overhead). 

Recalc: The time taken to recalculate the sheet after the workbook has 
been calculated, minus the time taken to recalculate an empty sheet 
(empty sheet overhead). 
Multi-threaded calculation is used if enabled.  
For most workbooks this will give a minimum worksheet calculation 
time because only the minimum set of formulas (mostly volatile 
formulas and their dependents) will be calculated.  

Full Calc: The time taken to calculate all the formulae on the sheet, minus 
the time taken to fullcalc an empty sheet (empty sheet overhead). 
Multi-threaded calculation is used if enabled. 
Colored orange if > (1+ orange tolerance) *average sheet full calc time 
and >orange tolerance *500 

Sheet Volatile %: The Ratio of Sheet Recalc time to Sheet Full Calc time. 
Measures how many of the formulae on the sheet are volatile. 
Colored orange if >orange tolerance * .125 

Multi-Thread Efficiency: A measure of the efficiency of multi-threaded 
calculation at sheet level. The ratio of Range calculation (single-
threaded) time to Full Calculation (multi-threaded) time. 

Other: The three times shown in the Other row are the times taken to 
calculate an empty worksheet. These times are used as standard 
calculation overheads and are subtracted from the sheet calculation 
times. 
Sheet % Volatile: The ratio of Recalc time to Full Calc time, excluding 
standard calculation overhead. When you have a high workbook volatility 
% you can use the sheet % volatile to determine which sheets are causing 
the problem. 
Microseconds per Formula: calculated from the smaller of used range calc 
time and sheet calc time. A high value may indicate bottleneck formulas. 

Colored orange if 
>orange tolerance * 
total sheet calc time and 
> (1+orange 
tolerance)*minimum 
sheet overhead and > 
orange tolerance * 500 

Colored orange if >(1+ 
orange tolerance) * 
average and > orange 
tolerance * 500 
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Worksheet Profiles Table (2) 

 
In the actual FastExcel output these columns are adjacent to the Calc Times columns rather than as shown above. 

Unused Cells: 
Eliminate the waste by 
using FastExcel’s 
Workbook Cleaner 

%Waste: The cells in the Used Range (formatted cells, constants, 
formulas, deleted/cleared cells) beyond the real Used Range (formulas 
and constants), as a percentage of the Used Range:  
Colored orange if > orange tolerance * 10000 cells. Significant waste 
can use additional memory and calculation time. 

%Sparse: Cells not containing formulas or constants, as a percentage of 
the used range. 
Colored Orange if > orange tolerance * 10000 cells. 

On sheet notes are counted 
as shapes 

Shapes Count: Count of the number of shapes in the Drawing layer for 
this sheet. Includes hidden and zero-height shapes. Use FastExcel’s 
Clean Workbook command to remove zero-height shapes. 

Colored orange if any of the shapes are linked by formula (slows 
calculation and editing). 

HyperLinks Count: Count of the number of Hyperlinks on this sheet. The hyperlinks can be internal or 
external to the workbook. Large numbers of hyperlinks can be slow. 

Sheet Calc Mode: Shows the MixMode calculation mode for the worksheet. 

 Book: The Sheet will be calculated whenever the Workbook calculates 

 F: The Sheet will be calculated at every Full workbook calculation. 

 M: The Sheet will be calculated at every Manual workbook re-calculation. 

 S: Shift-F9/worksheet Calculate will calculate the worksheet when it is selected 

Either Book or any combination of F M and S is allowed. 
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The Workbook Summary Table. 

Volatility% and MTC are 
key measures of 
calculation efficiency 

The Workbook Summary table shows the cell counts, workbook 
calculation times, workbook volatility, workbook overhead, bytes per 
cell, and names count, for the profiled workbook. The workbook 
Summary table is only produced if the Analyze the Workbook option is 
checked in the FastExcel Settings. 

The Workbook Summary Table Cell Counts. 

 
This shows totals of the counts and what-if tables for all the worksheets.  

Sheets Count: the total number of sheets in the workbook including Chart, Dialog, XLM Macro sheets as 
well as normal worksheets. 
 

The Workbook Summary Table Calculation Times. 

 
 Single-Thread: Total Time in milliseconds for 

Range.Calculate for the worksheets. The calculation is 
single-threaded. 

 Recalc: milliseconds to recalculate (F9) the workbook 
immediately after a full calculation. 

 FullCalc: milliseconds to fully calculate the workbook 
(Ctrl/Alt/F9). 

Keeping Workbook 
Volatility low is often an 
excellent way to improve 
response time. 
Colored orange if > orange 
tolerance * 0.125 

Book Volatile % is Recalculate Time as a percentage of full calculation 
time: a high value means one or more of: 

 High proportions of the formulas are Volatile 
 Evaluating the dependency trees takes a long time.  
 The workbook is too complex for Excel to build a 

dependency tree (status bar always shows Calculate and 
there are no circular references). 

 ForceFull calculation is true 
Multi-Thread Efficiency: A measure of the efficiency of multi-threaded 

calculation at book level. The ratio of the sum of range calculation 
(single-threaded) times for each sheet to Full Calculation (multi-
threaded) time for the book. 

 

MicroSecs per Formula: Microseconds per formula based on full calculation time. 



FastExcel V4 Profiler User Guide Page   40 

The Workbook Summary Table Used Range etc. 

 
The actual FastExcel workbook summary output includes cell count column and calculation times. These 
columns are not shown in the above figure. 

 %Waste: Cells in the UsedRange Outside the last Row and Column containing data or 
formulas, as a percentage of the cells in the usedrange. 

 %Sparse: Sparseness of the UsedRange: Cells inside the used range, but not containing 
formulas or constants, as a percentage of the used range. 

 Pivot Cache (K): Memory Used by Pivot Table Caches in this workbook in K bytes. 

 XLLinks Count: The Number of Excel workbooks that are linked to by the profiled workbook. 

 Names Count: count of the defined Names in the workbook. 

 Open Time (Secs): The time taken to reopen the workbook. 
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Profile Formulas and Functions 
This command allows you to profile and prioritize each unique formula on a worksheet and to analyse 
the functions used. Use this to drill down on a problem worksheet or worksheet area to the formulas 
you need to change.  

You can use this analysis to determine which formulas and functions are volatile and which formulas 
are single-threaded. 

 

You can choose to profile one or both of: 

 Worksheet formulas: either all formulas or the formulas in a selected area. 
 Functions used: either in all formulas or the formulas in a selected area. 

You can also request to time the individual functions, and set the warning tolerance level. 
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Worksheet Formulas Profile Table 

This table contains one row for each unique formula, sorted in descending calculation time order. 

Formula Address: Gives the addresses of the first few locations where this formula is used. If the 
formula is used in many different locations not all locations will be shown. 

Flags: One or more of the following formula flags: 

 A - This is an Array formula 
 B - This formula contains a Built-in, native Excel function 
 X - This formula contains a registered XLL function 
 O - This formula contains a VBA, Automation, or XLM function 
 N - This formula is not Volatile 
 V - This formula is Volatile 
 ? - Cannot tell if this formula is Volatile or not 
 M - This formula is Multi-threaded 
 S - This formula is probably Single-threaded 

All the formulas in this example contain functions that are Built-in to Excel (B), are Non-volatile (N) and 
are Multi-threaded (M): so the flag is B-N-M. 
VBA, Automation and XLM functions are always single-threaded but it is not currently possible to 
determine within the analysis if they are volatile or not, so they are flagged as? 

The analysis does not currently detect Defined Names containing volatile functions or single-threaded 
functions. 

Unique Formulas: Formulas that are copied and contain relative or absolute addresses are treated as 
being the same (they have the same R1C1 formula). 

Formula Count: The total number of occurrences of this formula within the area analysed. 
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Microsecs per Formula: The average time to calculate (single-threaded) a single occurrence of this 
formula 

Total Millisecs for this formula: Time in Milliseconds to calculate all the occurrences of this formula in 
this Sheet/Area using a single thread. =Time/Formula * Count 
Sorted largest first. 

Total Millisecs for this Area/Sheet: Total Millisecs for a single-threaded calculate of all the Formulas in 
this Sheet/Area. 

Formula % of Sheet Time: Total single-threaded calculation time for this formula as a percentage of the 
time for a single-threaded calculation of all formulas. 

Function Profile Table 

This table shows an analysis of the functions used, with optionally some indicative calculation timing. 

 

Local Function Name: The name of the function in the current User Interface Language 
Function Flags: Flags that describe the attributes of the function. 

 B-This function is a native, Built-in Excel function 
 X- This function is registered as an XLL function 
 O- Other: This function is a VBA or Automation function 
 V- This function is Volatile 
 ?- Cannot tell if this function is volatile or not 
 N- This function is Not volatile 
 S- This function is probably single-threaded 
 M- This function is multi-threaded 
 A - This function is an Asynchronous function 

Function Count: The total number of occurrences of this function. 
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Average Millisecs per function: The Average Time to calculate this function In Milliseconds:  
(Note that there may be other function calls etc. embedded inside this function, and the function may 
also be used in several different formulas) 
Total Millisecs This Function: Time in Milliseconds to calculate all the occurrences of this function in this 
Sheet/Area using a single thread. =Time/Function * Count 
Note: Timings for functions are indicative only and may not be accurate. Function timing is most 
accurate when the function returns only a single value and when each occurrence of the function is used 
in an identical formula. 
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Profile Worksheet Areas 

  Profile Worksheet Areas: Shows the Profile Header block, and profiles each rectangular block of 
formulas and, optionally, each column and each block of rows on each of the selected worksheets.  

The Profile Worksheet Areas command shows you a form to allow you to choose between options. 

Choose Profile Worksheet Areas Options 

 

You can choose to profile one or more of: 

 The contiguous areas on the worksheet(s): either all or the selected areas. 
 The Worksheet Columns within the areas: choose the number of groups of columns you want – 

larger number gives finer granularity but takes longer. 
 The Worksheet Rows within the areas: choose the number of groups of rows you want – larger 

number gives finer granularity but takes longer. 

You can also choose to show counts of formulas and formula lengths – but this uses more time. 

The warning tolerance (Orange tolerance) controls the sensitivity of flagging the results as warnings. A 
larger number means more warnings. 

Profile Selected Area 

After reviewing the output from Profile Worksheet Areas you can select one or more of the problem 
areas on the worksheet that was profiled and use profile Selected Area to drill down into that area. 
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Worksheet Areas Profile Table 

Use the tables to identify 
Bottleneck areas on the 
worksheet. 

There will be three Worksheet Areas Profile Tables for each of the 
selected Worksheets. 

All calculation times in these tables are single-threaded calculation 
times. 

 Cell counts of formulas, array cells and conditional formats. 
 Calculation times for the area, column and the sheet. 
 Total, average and maximum formula lengths. 

Each table is sorted in descending calculation time sequence. 

The first table profiles each separate contiguous rectangular area of formulas on the worksheet: 

The second table profiles the columns: the number of column groups should be no more than the 
number specified in the options. The column groups are sorted in descending calculation time sequence. 

The third table profiles the rows in the same way as the columns. 
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Map Worksheet Cross-references. 

Map Worksheet Cross-references produces a tabular map showing how the references between worksheets. 

Worksheet Cross-references occur when a formula on one worksheet refers to another worksheet. 

 

Optionally you can also request that the worksheets are re-sequenced to minimize the number of worksheet cross-
references: but note that with current Excel versions this will generally have little or no impact on calculation 
times. 

Worksheet Calculation Sequence Forward Cross-reference Tables. 

The output is one or two tables of worksheet cross-reference counts, with forward cross-references highlighted in 
orange: 

The first table shows forward cross-reference counts using the Current Worksheet Calculation Sequence. 

The second table shows the Optimized Worksheet Calculation Sequence, and its effect on the forward 
cross-reference counts. 
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Worksheet Forward Cross-reference Tables: Sheet Refers-To and Referenced-By: 

Rows show Refers-To counts Reading a row across the table shows you the refers-To counts. 

 Columns show Referenced-By 
counts 

Worksheet Forward Cross-reference Tables: Color-Coding: 

Orange cells show problem 
areas 

Orange highlighted cells show forward worksheet references. These are the 
most common cause of excessive workbook overhead. 

Bright green cells on the diagonal are empty because FastExcel does not count references within a sheet. 

Light green columns show worksheets that are not referenced-by any other sheet. These are typically report 
sheets: for example, the Summary sheet. 

Light green rows show worksheets that do not refers-to any other sheet. These are typically sheets containing 
the input data. 

Using the optimized Sheet calculation sequence: 

Changing the worksheet 
names changes the 
worksheet calculation 
sequence 

If FastExcel has significantly reduced the forward references you will be asked if 
you want to automatically change the sheet names. 

NOTE: In Excel97 and Excel2000 Excel’s worksheet calculation sequence is the 
alphabetically sorted worksheet name sequence rather than the sequence of 
the worksheets in the workbook. 
 In Excel 2002 and later versions the worksheet calculation sequence is 
generally not important to calculation time. 

Circular Worksheet Cross-reference Paths table 

If FastExcel can’t find a worksheet calculation sequence with zero forward cross-references it’s probably because 
the workbook contains circular cross-reference paths. 

 

The Path Length column shows the number of worksheets involved in the circular path. 
In complex workbooks there may be thousands of unique circular paths. FastExcel is designed show you the 
shorter paths first, and will not attempt to find paths containing more than 6 sheets. 
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FastExcel VBA Profiler 

ProfVBA Overview 

 

FastExcel VBA Profiler works by adding timing and tracing calls to the projects and procedures you want 
to profile, so that profiling statistics are accumulated when you run the VBA. 

These ProfVBA commands are also available in the VBE IDE from the ProfVBA Toolbar and the Add-Ins 
menu item. 

 

Use the ProfVBA toolbar when working with particular procedures open in the VBE to add profiling calls 
around selected blocks of VBA statements or around all the loops in particular procedures. 
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Note: Adding Profiling Calls requires “Trust Access to the VBA Project Object Model” to be checked. 

 

 

 

ProfVBA Acknowledgements 
Many thanks to Stephen Bullen and Rob Bovey for their help with ProfVBA: see pages 546-500 of 
“Professional Excel Development” ISBN 0-321-50879-3. 
 
And many thanks also to Don Soloway who extended ProfVBA to handle profiling of Loops and Iterations 
of Loops and added the Inline Command options. 
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Add Profiler Calls 
Add Profiler Calls allows you to control which projects, modules and procedures to profile. 

Selecting a Project will show all the modules in that project. 
Selecting one or more Modules will show all the Procedures in those Modules. 

 

Note: Profiler calls can only be added to unprotected projects 
Clicking OK adds calls to the FXL VBA Profiler at the start and end of each procedure. 
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Adding Drill-Down Profiler Calls using the Ribbon 
You can add drill-down profiler calls to locate slow VBA blocks of code or slow VBA loops. 

The recommended way of doing this is to: 

 Select statements or a procedure (Sub or Function) in the VBE  
 Then click the “Profile Statements” or “Profile Loops” buttons on the ProfVBA Toolbar in the VBE 

 

Profile Statements will wrap the selected VBA statements in profiler Start and End calls. 
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Profile Loops will wrap each loop within the selected procedure in Profiler Start and End calls, and will 
handle nested loops (up to a maximum (default 10) set in Add Profiler Calls). 

 

 

You can repeat these steps to add profiler calls to many different blocks of VBA. 
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Adding Drill-Down Profiler Calls using “Add Profiler Calls” 
You can also add drill-down calls from the “Add Profiler Calls” form. 

Every Nth Line 
Selecting one or more Procedures enables the “Every Nth line of Proc”, “All Loops in Proc” and “Every 
Iteration of Loops” options.  

Use one of these options when you want to drill-down into specific procedures to see which lines of code 
in the procedures are consuming the time.  
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The Nth Line option adds End and Start pairs of calls after every Nth line (3 in this example) 
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All Loops in Proc to Max Depth 
This option wraps every loop in the selected procedure on profiler calls.  

Max Depth refers to the maximum level of loops nested inside other loops that is allowed. 

The Profiler recognises FOR, DO and WHILE loops. 

 

 

The Profiling report shows the results for each Loop. 
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Every Iteration of the Loops 
This option inserts Profiler calls inside each loop, so that the profiler records each individual pass 
through the loop. 

 

The Profiling Report shows results for each iteration. I sorted the results on the first column to show 
them in execution sequence. 

 

 

 

Create a VBE Reference to FastExcel Profiler 

 

The profiler calls that are added to your VBA code call into FastExcel VBA Profiler, and so require a 
reference to be created. 
Clicking OK will add the references and provide a status message. 
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And prompt you to Enable Profiling or Tracing. 

 

 

Show Timings in the Immediate Window 
Choosing this option will show timing results in the immediate window. This enables rapid speed testing 
of changes to the VBA.  

All Loops in Proc Immediate Output 

 

Note: The results are output to the immediate window at the conclusion of each Profile_Start and 
Profile_End block and are not aggregated. This in contrast to the Profiling Report where the results of 
each pass through a block are aggregated: 
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Every Iteration of Loops Immediate Output 

 

 

The Loop iterations are labelled slightly different for the 3 different types of loops (For To, For Each and 
Do). 

The general format is 
procedureName.loopType_UID1.variableName:depth.UID2 

Where 
 loopType is one of the following, For To, For Each, or Do Loop 
 UID1 is a loop unique identifier that can be seen in the user code.  This is to support in finding 

the loop which this timer measured, 
 variableName is the loop variable for the For To and For Each loops.  The Do loop does not have 

a loop variable, 
 depth is the nested depth value.  Subroutine and functions will be counted as a depth down, 
 UID2 is a unique identifier that is generated at runtime.  This is required to identify the path a 

For Each or a Do loop is taking.  For the For Each and Do loops, the UID2 is based on a counter 
that labels the loops sequentially when that loop is first called.  For the For To loop, the UID2 is 
the value of the increment variable. 
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Remove Profiler Calls 
This command tidies up your VBA code by removing ProfVBA calls and References in a similar way to Add 
Profiler Calls. If you have manually added profiler calls note that Remove is case-sensitive. 

 

And gives a status message. 
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Settings, Enabling and Disabling Profiling and Tracing 
After you have added Profiler Calls to your VBA code, profiling and tracing does not start until you 
enable it and then run your VBA code. 

Note: Profiling and Tracing are mutually exclusive: starting one stops the other. 

 

 

Enable Profiling Options  
Exclusive timing  

Shows only the actual time taken by a procedure and excludes time taken by child procedures called by 
the procedure. 

Inclusive timing  

Shows the total time taken by a procedure including the time taken by all its child procedures. 

Decimal Places 

Controls the number of decimal places of milliseconds to show in the result. Minimum 0, Maximum 4, 
Default 2. 
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Show Timings in the Immediate Window 
When this is checked results will be shown in the VBE Immediate window as well as being available to 
the Profiling report. 

 

As noted above the Immediate Window results are output at the conclusion of each Profile_Start and 
Profile_End block and are not aggregated. This in contrast to the Profiling Report where the results of 
each pass through a block are aggregated. 

 

The Immediate Window results can be Exclusive or Inclusive. 
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Show ProfVBA Status 

 

ProfVBA Status shows you the current profiling status and settings.  

Note: there are Profiling Results available to report. 
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Show Profiling Report 

 

The profiling report is created as a worksheet called FastXLProfVBAn in a separate workbook. 

The report timings shown are exclusive: they show the timed used by a procedure excluding the time 
taken by the calls from that procedure to other procedures. When using the Inclusive setting the time 
taken by the calls for a procedure will include both the time taken by the procedure itself and the time 
taken by all the procedures it has called. 

In this example SetAllExpColors is using 22% of the execution time. To drill down into that procedure, 
“Remove Profiler Calls” then “Add Profiler Calls” for SetAllExpColors using either the Nth line option or 
the Profile Selected Statements option or one of the Profile Loops options. 

For ease of use Profile Statements and profile Loops can be used from within the VBE and act on the VBE 
selected statements or procedure. 

It turns out that in this case the profile shows that 85% of the time used in SetAllExpColors is turning 
Screen Updating back on after colouring the cells. 
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Call Sequence Counts 

The Profiler maintains independent calling sequence counts for the first entry call to a procedure and the 
last exit from a procedure. So, if Proc1 is the first Proc and calls Proc2 which then exits and returns to 
Proc1 which then exits you would get: 

Proc Name Start Sequence Exit Sequence 

Proc1 1 2 

Proc2 2 1 

 

Sorting by Start Sequence or Exit Sequence gives a quick way of looking at the starting or ending flow of 
your procedure calls. 

For a more comprehensive trace see FastExcel Trace below. 

Uncaptured Exits 
If a VBA procedure exits without reaching a ProfVBAProcEnd statement it will not show in the Profiling 
Report. 
The time taken by an uncaptured exit procedure is accumulated into the procedure that it exits to. 

The most frequent cause of uncaptured exits is a higher-level error handler: 

Sub1 contains an On Error statement to capture VBA errors, and calls Sub2. 

Sub2 calls Sub3 

Sub3 calls Sub4 and then causes a divide by zero error after the Sub4 call. 
This error passes control directly to the error handler in Sub1, bypassing the execution of the 
ProfVBAProcEnd calls in both sub 3 and sub2. 

The Profiling Report therefore will not show the time taken by Sub2 and Sub3 and it will be accumulated 
into Sub1. 
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FastExcel Execution Tracing 
Because VBA is an event-driven language it can be difficult to work out the path execution takes through 
your code. 

If you need to trace the flow of execution through a sequence of procedure and event calls you can use 
FastExcel Trace Profiling. 

First you need to Add Profiler Calls to the VBA code you want to trace (usually start by adding to all 
modules and procedures), in exactly the same the same way as for Profiling. 

Start VBA Trace 

 

The Trace report is appended to a .txt file in the same folder as the active workbook, rather than as a 
worksheet report. This ensures that as much of the trace as possible survives a crash. 

Stop VBA Trace 

 

Use Stop VBA Trace to ensure that all trace results are written to the file. 
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The Trace Report .txt File 

 

 

The starting number and indentation show the start and end calling level for the procedure. 

Uncaptured Exits in the Trace Report 

If uncaptured exits have occurred the last trace line shown will be indented and its calling level will not 
be 1. 

See Show Profiling Report – Uncaptured Exits for a more detailed explanation. 
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Advanced Use of ProfVBA: Inline Commands 

 
Don Soloway extended ProfVBA to be able to use commands embedded as comments in the VBA code to 
drive the addition of Profiler calls for Loops. 

This allows you to retain profiling instrumentation in interesting areas of your code without impacting 
execution. 

Then you can call Add Profiler Calls to easily regenerate all the profiling start and end calls. Calling 
Remove Profiler calls will remove the Start and End calls but leave the Inline Commands intact. 

The format of the inline commands is as follows: 
 
‘TagString Start profilerName [variableName] [stackPush] 
‘TagString End profilerName [variableName] [stackPop] [displayToImmediate] 
 
Where 

 TagString is an identifying string to indicate that an inline command follows.  The TagString 
currently equals gfxlProfVBA.   

 profilerName is a user specified name for that timer 
 variableName is the increment variable name for the For To loops 
 stackPush is to save the UID2 for nested loops 
 stackPop is to retrieve the UID2 for nested loops 
 displayToImmediate is to indicate that output is sent to the immediate window.  This takes the 

value of True or False. 
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Calculation Manager 
Note: Calculation Manager is not available with Windows FastExcel Manager Pro. 
FastExcel Extended Calculation Modes are only available with FastExcel V4 SpeedTools and FastExcel 
Manager Pro for Mac 

 

 

Calculation Manager gives you: 

 Full Control of all Excel’s calculation settings 

 Call the Calculation methods from buttons or keystrokes 

o Calculate Full Rebuild Dependencies 

o Calculate Full all open workbooks 

o Recalculate all open workbooks 

o Recalculate Worksheet 

o Full Calculate Worksheet 

o Calculate Range 

o Mixed Mode Recalculation 

 Accurate timing for each calculation method 

o On Windows timing accuracy is at the Microsecond level, although in practice other 
factors such as Windows multi-tasking prevent timing tasks reaching this level of 
accuracy. 

o On Mac timing is accurate at best to around 4 milliseconds. 
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Calculation Manager Options and Settings 
The settings are in three groups: Excel Settings, Workbook Settings and FastExcel Settings. 
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Excel Calculation Settings 
Excel’s default methods for Determining Calculation Mode. 

By default, Excel uses the 
same calculation mode for all 
open workbooks.  
The Calculation mode is 
initially set from the first 
workbook opened and is not 
changed when other 
workbooks are opened.  
 

Excel uses the same calculation mode for all open workbooks. 

Excel sets the initial calculation mode from the first (previously 
saved) workbook opened. This initial calculation mode will not 
change when additional workbooks are opened, and will only change 
when either the user or a VBA program changes it. If you start Excel 
with a brand-new empty workbook and make changes to that 
workbook then the calculation mode is Automatic. 

If a manual mode workbook is opened in automatic mode the 
workbook will be calculated. 
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Excel Current Calculation Mode 
You can use this form to view and change Excel’s current calculation status and settings. 

 

By default, the current 
Excel calculation mode 
applies to all the open 
workbooks.  
Also, all the open 
workbooks are 
recalculated, not just one 

Excel’s default calculation mode is at the Excel session level.  
This means that Excel will use the same calculation mode for all open 
workbooks, regardless of the calculation mode that was saved with an 
individual workbook.  

Whenever Excel calculates the default behavior is to calculate all the 
open workbooks, rather than just the active workbook 

Automatic 

Formulas are recalculated automatically whenever anything changes so that the workbook(s) are always 
calculated. 

Automatic except Tables 

Similar to automatic except that Excel Tables are not automatically calculated. This can be useful with 
large workbooks because Excel Tables cause multiple calculations of the workbook. 
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Manual 

The status bar will also 
show “Calculate” if there 
are circular references or 
ForceFullCalculation has 
been turned on. 

Formulas are only recalculated when the user requests it by pressing F9 
or the FastExcel recalculate button. When the workbook is not 
completely calculated the status bar shows “calculate”. 

Recalculate before save. 

If in Manual mode checking this option will cause Excel to recalculate uncalculated formulas in the 
workbook each time it is saved. 

Excel Iteration 

These settings control how Excel handles circular references. 

 

Iteration 

When checked Excel will attempt to resolve formulas that are linked by circular references by repeatedly 
calculating them. 

Maximum iterations and Maximum change 

Excel will stop the repeated calculation of the circular references as soon as either the maximum number 
of iterations has been reached or the maximum change in the values of all of the formulas is less that the 
specified maximum change. 

Multi-threaded calculation Settings 

 

Enable MTC 

When Checked Excel (Windows Excel 2007 and Mac Excel version 16 and later) will split the calculation 
process over multiple threads. This will improve calculation speed on many problems, particularly with 
large workbooks and multiple recalculations. 

Use all Processors/Manually Assign threads 

You can control the maximum number of threads to be used by Multi-Threaded calculation 
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Excel Calculation Buttons 

 

The calculation timer for 
these buttons is controlled 
by your FastExcel settings 

The Excel Calculation Settings Tab also contains buttons to request 
various types of calculation. FastExcel will show the time taken by the 
calculation if the calculation timer for buttons is switched on. 

Using FastExcel defaults Excel will calculate all enabled worksheets in all open workbooks, and will 
calculate all MixMode sheets with a Full calculate, and selected MixMode sheets with a Sheet 
calculate. 

Calc Full Rebuild (Shift-Ctrl-Alt-F9) 

By default, MixMode sheets 
are calculated if Mixed 
Mode Full Calculate is on 

Calculate Full Rebuild rebuilds the dependency trees and then fully 
calculates all formulas in all open workbooks. This option is only 
available from Excel 2002 onwards. 

Calc Full (Ctrl-Alt-F9) 

By default, MixMode sheets 
are calculated if Mixed Mode 
Full Calculate is on 

Calculate Full fully calculates all formulas in all open workbooks. 

Recalc (F9) 

Recalculation is the default 
Excel calculation process. Only 
changed cells and formulas 
dependent on changed cells 
are calculated 

Recalculate recalculates all formulas in all open workbooks that 
have been changed or are volatile, or are dependent on a cell that 
has been changed or recalculated. 
By default MixMode sheets are calculated if calculation mode is 
Manual and Mixed Mode Manual is on. 

Recalc Sheet (Shift-F9) 

Sheet Calculate re calculates 
the selected Sheets assuming 
that all precedent worksheets 
and linked workbooks have 
been correctly calculated. 

Recalculate Sheet recalculates all formulas on each selected 
sheet that have been changed or are volatile or are dependent 
on a cell on the selected sheet that has been changed or 
recalculated. By default, MixMode sheets are calculated if Mixed 
Mode Selected Sheets is on. 
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Fullcalc Sheet (Alt-Shift-F9) 

Full Calculate Sheet calculates 
every formula on the selected 
Sheets assuming that all 
precedent worksheets and 
linked workbooks have been 
correctly calculated. 

Full Calculate Sheet calculates all formulas on each selected sheet. 
By default MixMode sheets are calculated if Mixed Mode Selected 
Sheets is on. 

Calc Range (Alt-F9) 

Use FastExcel Calculation 
Control->FastExcel Settings to 
choose between the 2 available 
Range Calculate methods (with 
or without dependencies internal 
to the selected range) and the 
number of Range Calculate trials 
(default 3). Range Calculate then 
shows the median time of all the 
trials 

Range Calculate calculates the currently selected range of cells.  
If more than one Area is selected; each Area is calculated left-to-
right and top-to-bottom, in the sequence that the areas were 
selected. 
If more than one worksheet is selected then only the selected 
range on the active worksheet is calculated.  
If one or more of the selected cells is part of a multi-cell array 
formula then all the cells in the array formula will be included in 
the calculation. 
If Calculation is set to Automatic both the time taken to 
calculate the range in Manual mode and the workbook 
recalculation time are shown.  

Dirty Range 

Flags the selected cells as uncalculated. This option is only available in Excel 2002 or later. In automatic 
mode this will trigger a recalculation. 

MixMode Recalc (Ctrl-Shift-F9) 

Recalculates both MixMode and 
ordinary sheets. 

MixMode Recalc is similar to Recalc (F9), except that the 
recalculation also includes all Mixed Mode sheets. 

These calculation buttons are also available on the FastExcel Profiler and FastExcel Manager Pro for Mac ribbons. 
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Workbook Calculation Settings 

 

Workbook Calculation Settings: Workbook Options 

 
Restore Workbook Calculation Mode after open 

This option is only available with FastExcel V4 SpeedTools and FastExcel Manager Pro for Mac 

 

Force Full Calculation 

This option is only available in Excel 2007 and Mac Excel Version 16 or later. 
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If checked every calculation on this workbook will be a full calculation rather than a recalculation, and 
the time taken to rebuild the dependency trees will not be needed at workbook open time or when the 
workbook is edited. 

Switch on Force Full Calculation if adding a row at the top of a worksheet is very slow and Full Calculate 
time is close to Recalculate time. 

Update Remote References 

If TRUE automatically update any remote references (DDE Links to other programs) whenever Excel 
recalculates. 

Save External Link Values 

If TRUE Excel will save values for the links to external workbooks. I recommend keeping this option as 
TRUE 

Precision as Displayed 

Checking this box will force Excel to calculate to the number of decimal places that appear as a result of 
your formatting, and will permanently change any numbers stored in cells. 
You need to be sure you have thought through the full implications of this before using it. 
Precision as Displayed slows down calculation. 

1904 Date System 

If TRUE changes the starting date from which all dates are calculated from January 1 1900 to January 2 
1904. 

Accept Labels in Formulas 

This allows Excel to use natural language labels in formulas. Because there are circumstances when this 
will give you unexpected or ambiguous results, I recommend you do NOT use this feature. 
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FastExcel Settings 

 

Calculation Timers for buttons and keys 

You can control the FastExcel calculation time display separately for the calculate buttons and the 
calculate keys.  

When checked you will see a message box after the calculation showing the time taken by the 
calculation. 

Range Calculate Settings 

 

Range Calc including or excluding Dependents 

In Excel 2007 and later there are 2 different Range calculate methods. One includes within-range 
dependency calculations and the other ignores within-range dependencies and calculates row by row 
strictly left-to-right and top-to-bottom. Range Calculate always ignores dependencies outside the 
selected range, although the selected range will be expanded to include all the cells in multi-cell array 
formulas. 

Set Number of RangeCalc Trials 

Because RangeCalc timing can be sensitive to Windows multi-tasking it is better to allow a number of 
trials. The Median (middle-most) calculation time will automatically be used, thus discarding incorrectly 
high and low values. 

You can set the number of trials: the default number is 3. 
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Include Screen Refresh Time 

If checked timings for Range Calculate will include the time used by Excel to refresh the visible window. 
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Calculation Timing Commands 

There are seven FastExcel calculation timing commands. 

These buttons calculate the selected items and optionally show you the elapsed time taken by the 
calculation. 

 

Use FastExcel Calculation 
Control->FastExcel Settings 
to choose between the 2 
available Range Calculate 
methods (with or without 
dependencies internal to the 
selected range) and the 
number of Range Calculate 
trials (default 3). Range 
Calculate then shows the 
median time of all the trials. 

The currently selected cells, using Range Calculate. Alt-F9 
If more than one Area is selected; each Area is calculated left-to-right 
and top-to-bottom, in the sequence that the areas were selected. 
If more than one worksheet is selected then only the selected range on 
the active worksheet is calculated.  
If one or more of the selected cells is part of a multi-cell array formula 
then all the cells in the array formula will be included in the calculation. 
If Calculation is set to Automatic both the time taken to calculate the 
range in Manual mode and the workbook recalculation time are 
shown. 
 

The currently selected sheet(s), using Sheet Recalculate. Shift-
F9. 
If more than one worksheet is selected all the selected worksheets are 
recalculated. If Calculation is set to Automatic both the time taken to 
recalculate the sheet(s) in Manual mode and the subsequent workbook 
recalculation time are shown. If MixMode sheets are selected by 
default they will be calculated 

 

The currently selected sheet(s), using Sheet Full Calculate. 
Alt-Shift-F9. 
If more than one worksheet is selected all the selected 

worksheets are recalculated. If Calculation is set to Automatic both the 
time taken to recalculate the sheet(s) in Manual mode and the 
subsequent workbook recalculation time are shown. If MixMode 
sheets are selected by default they will be calculated 

All enabled sheets in open workbooks. Recalculate. F9. 

Sheet Calculate re calculates 
the selected Sheets 
assuming that all precedent 
worksheets and linked 
workbooks have been 
correctly calculated. 

Full Calculate Sheet 
calculates every formula on 
the selected Sheets 
assuming that all precedent 
worksheets and linked 
workbooks have been 
correctly calculated. 

Recalculation is the default 
Excel calculation process. 
Only changed cells and 
formulas dependent on 
changed cells are calculated 
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Full calculation calculates all 
formulas in all open 
workbooks 

MixMode sheets are not calculated unless Manual Calculation has 
been checked in MixMode options. 

Calculate all open workbooks. Full Calculation. Ctrl-Alt-F9 

Recalculate MixMode Sheets: All enabled sheets and any 
MixMode sheets in all open workbooks are recalculated. Ctrl-Shift-F9. 

 

Select, run and time a macro. 
 

To control the display of the calculation time, see FastExcel Calculation 
Control  -> FastExcel Settings. 
There are keyboard shortcuts for these calculation commands. 

 

 

Recalc MixMode Sheets 
recalculates all sheets 
including MixMode sheets. 
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Getting Consistent Results from FastExcel V4 Timing 
Sometimes you will find that your FastExcel timing results are not repeatable, even though FastExcel 
measures elapsed time using a high-resolution timer with microsecond accuracy. 

Power Saving and Multi- Core processors: 

Power saving features, particularly on dual-core processors, may dynamically vary the speed of your 
processor. This can create problems for consistent timings using the high-resolution timer. If timing 
consistency is important try switching off the power-saving features of your processor. 

Excel minimizes the number of calculations: 

When Excel calculates it remembers: 

 Which cells have been calculated. 

 The optimum calculation path used for the final answer. 

The second calculate is 
often much faster than 
the first 

So, the next time Excel calculates it can save time by: 

 Only calculating the cells that have changed (or depend on cells 
that have changed) 

 Re-using the last calculation path 

 

Why FastExcel Timing results may vary from run to run: 

Both Excel and Windows 
cache information to speed 
up subsequent operations 

Both Excel and Windows try to optimize performance by storing recent 
information in memory. This includes the calculation path used by the 
most recent calculation.  

So, Excel’s second calculate is often significantly faster than the first. 

Excel also saves some of this information, including the most recent 
calculation path, with the workbook. 

 

Windows is a multitasking, paged virtual memory operating system so 
other system tasks are always running at the same time as Excel. Try 
and make sure there are no other user tasks active whilst you are using 
FastExcel. 

 

Excel’s background calculation process can be interrupted if you press 
any key or click the mouse whilst FastExcel is active. This may give you 
inaccurate timings. 

Windows is a multitasking 
system so Excel does not 
get the whole system to 
itself 

Excel’s background 
calculation process can 
easily be interrupted 

FastExcel V4 can help you quickly find out how much memory Excel is using. 
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Calling FastExcel Methods from VBA 

Calling FastExcel Profiling Methods 
FastExcel V4 Profiler has a VBA API that enables you to call the FastExcel Profiling commands from VBA. 

You first need to add a reference to your VBA project that references FastExcel V4 Profiler: 
Alt-F11 to go to the VBE, then Tools References and check the box beside fxl4Profiler. 

Now in your VBA code you can add statements like 

Fxl4Profiler.vbaProfDrillAPI 

This calls the Drilldown profiler on whatever is currently the active workbook. 
It is not generally a good idea to make this call when your VBA code is within the active workbook, 
because by default the Profiler closes and then reopens the workbook, thus interrupting your VBA. 

The available Profiling APIs are: 

fxl4Profiler.gblSilentProfile – a boolean switch that, when True, prevents the Profiling commands from 
showing messages and user-forms. 

fxl4Profiler.gblNotReopenBook – a boolean switch that, when set to True, prevents the Profiling 
commands from finding worksheet overheads and closing and re-opening the profiled workbook. 

Use this switch if you are using the ProfDrillAPI from within the workbook to be profiled. 

fxl4Profiler.vbaProfDrillAPI – this runs the FastExcel Drilldown Profiler on the active workbook 

fxl4Profiler.vbaProfBookAPI – this runs FastExcel Profile Workbook on the active workbook 

fxl4Profiler.vbaProfSheetAPI – this runs FastExcel Profile Worksheet on the active worksheet 

fxl4Profiler.vbaProfFormulasAPI – this runs FastExcel Profile Formulas on the active worksheet 

fxl4Profiler.vbaProfCheck – this runs FastExcel Check workbook on the active workbook 

NOTES: 

 Calling one of these profiling commands will generally change the active workbook. 
 If you want to call two commands in succession from your VBA, make sure the VBA resets the 

active workbook and active worksheet appropriately before each command. 
 When using gblNotReopenBook it is NOT recommended to save the profiled workbook after 

ProfDrill or ProfBook. Instead close and reopen the workbook manually after Profiling. 
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Calling FastExcel Calculation Methods 
If you are using any of FastExcel’s additional calculation modes and options and your VBA program is requesting 
Excel calculations you should use FastExcel’s enhanced calculation methods. 

If you use Excel’s standard calculation methods either FastExcel’s additional calculation modes and options will not 
operate or you may get unexpected results. 

You can access FastExcel’s calculation methods from VBA either by using Application.Run or by setting a reference 
in your VBA project to SpeedToolsV4: Alt-F11 to go to the VBE, then ToolsReferences and check the box beside 
SpeedToolsV4. 

The available calculation methods are: 

FxlRangeCalc 

FxlRangeCalc calculates the selected range on the active sheet in the same way as the FastExcel Calculate Range 
button. 

FxlSheetCalc 

FxlSheetCalc recalculates the selected worksheet(s) in the same way as the FastExcel Recalculate Sheets button. 

FxlFullSheetCalc 

FxlFullSheetCalc  full calculates the selected worksheet(s) in the same way as the FastExcel Full Calculate Sheets 
button. 

FxlBookCalc 

FxlBookCalc recalculates workbooks in the same way as the FastExcel Calculate Book button. 

FxlFullbookCalc 

FxlFullBookTime does a full workbook calculation in the same way as the FastExcel Full Calculate button. 

FxlDisabledSheetsCalc 

FxlDisabledSheetsCalc recalculates workbooks including Mixed mode worksheets. 

FxlFullDependCalc 

The workbooks will have their dependency trees rebuilt and a full calculation will be done. 
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MICROTIMER function 
The MICROTIMER function is a wrapper function for the Windows high-resolution timer API. 

The function returns a double containing seconds. The resolution of the timer is dependent on the clock speed of 
your PC, but is about 1 microsecond on a 1200MHZ AMD. The function itself takes about 5 microseconds to 
execute when called from VBA on the same machine. 

The function is not volatile, and is primarily designed to be called from VBA Subs/Functions rather than from a 
worksheet. 

MICROTIMER Syntax 

MICROTIMER() 

MICROTIMER Remarks 

To call the function from VBA you must first make a reference from the VBE to FastExcelV4: 

 Open the VBE (Alt F11) 

 Open a module within your VBA project 

 Tools->References and check FastExcelV4. 

It is also possible to evaluate the function from VBA as a worksheet function using Evaluate, but this incurs 
significant extra overhead. 

MILLITIMER function 
The MILLITIMER function is a wrapper function for the Windows medium-resolution timer API. 

The function returns a long containing milliseconds. The resolution of the timer is about 5 milliseconds. The 
function itself takes about 1 millisecond to execute when called from VBA on the same machine. 

The function is not volatile, and is primarily designed to be called from VBA Subs/Functions rather than from a 
worksheet. 

MILLITIMER Syntax 

MILLITIMER() 

MILLITIMER Remarks 

To call the function from VBA you must first make a reference from the VBE to FastExcelV4: 

 Open the VBE 

 Open a module within your VBA project 

 Tools->References and check FastExcelV4. 

It is also possible to evaluate the function from VBA as a worksheet function using Evaluate, but this incurs 
significant extra overhead. 
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STRCOLID function 
The STRCOLID function returns an alphabetic column name (A to XFD) given a column number. 

STRCOLID Syntax 

STRCOLID(jColNo) 

JColNo 

jColNo is the number of the column you want to convert to a column name. 
STRCOLID Remarks 

If the column number is greater than 16384 STRCOLID returns #N/A 

STRCOLID can be used either as a worksheet function or from VBA. 

The main use of STRCOLID as a worksheet function is to calculate a cell address as a string for use with INDIRECT.  
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Migrating from FastExcel V3. 
Both FastExcel V3 and FastExcel V4 can be installed on the same system whilst testing and migrating 
workbooks, but it would be better to uninstall FastExcel V3 once this period is over. 

 

 


